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macro- | makro|
From the Greek makros “large”

Large on your sensor




Think Dragonfly
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macro photography
.| or greater reproduction ratio

Image on Camera Sensor Physical Object

| Reproduction



The FCDCC macro

SIG is really a
close-up™ photography
special interest group

How close Is up to you.

Russ Lawry



Close-up photography is just plain fun!

Russ Lawry



Combine close-up with the Portrait SIG
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BE FAMILIARS
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Close up photo of my monitor



i NOT S5O FAMILCIEAER

Macro photo of my monitor



FUNGUS NOT FOREST
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DO CUMEN TARY SHOTS, SCALE 1S CREFICH .

“Them!”

|5k

VVarner Bros.




NO SCALE - CAN ADD INTEREST




FRAC | ICE SARE
PHOTOGRAPHY

Focal length Matters

Sometimes you can’t get close to your subject without scaring it.

Or it biting you.



IS TANCE MATTESS




IS TANCE MATTESS




ORIGINAL




EErEAl FOR DRAMAITIC EFFESSS




Dl

FEREN | VWAYS 1O GET CECH.

Free Crop
* Macro Couplers
 Reversing Ring
* Microscope adapter
* Screw on close-up lens
* Extension tubes
» Teleconverter
* Bellows
* Macro lens

DR C S



e O COUNES

Connects two lenses FACE to FACE by their filter threads

magnification = focal length of primary lens / focal length of the
reversed lens

High magnifications.

Small subject to lens distances.

Reversed lens should have manual aperture ring (or lever).

General Brand 52mm to 58mm
Macro Coupler - For Mounting

Lenses of 52mm & 58mm Face to You Pay: $7.95

Face _
B&H # GBMC5258 * MFR # AMS5258 ( View Cart )

Availability: IN STOCK Ship Time: Order Now to + Add to Wish List
ship Tomorrow (:‘;?:)
'8 & & & 030
Free Expedited Shipping on Orders over $49 @



ABREB

alka: Frankenlens

PLER

Rubber band, adapter,
or manual aperture (best)



e O COUNES

Quality can be good even though | did everything wrong.




FOCUS RAIL




FOCUS RAIL




Al RO COUPLE

300mm lens with a 50mm lens reversed
5.3x magnification, not cropped

| mm

l _ I

Addeg ||



e O COUNES

Dragonfly wing




e O COUNES

Dragonfly wing
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Lens was ~ |cm from subject
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Don’t make mistakes like this vignetting.

See

http://coinimaging.com/coupled lenses.html
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http://coinimaging.com/coupled_lenses.html

REVERSING RING

Lets you mount the lens backwards on the camera body

» Your lens should have a manual aperture ring!

» High magnifications.
» Small subject to lens distances.

General Brand Reverse Adapter for Mounting Lenses
with 52mm Filter Threads Backwards on Nikon Bodies

B&H # GBRRN52 » MFR # AV52N

IN STOCK

(GENERAL BRAND)
Order Now to ship Tomorrow You Pay: $1 1 .99
free Expedited Shippingon Ordersover | ———
$49 1 qry

W % W W I Reviews 25 Q&A3 Add to Cart

Questions? Ask our experts:



Tl LENS REVERSERS

Full frame shown 4.5:|




REVERSING RING

Macromania

Focal Length Reproduction Ratio
| 6mm A OD
20mm Do
24mm 2.6X
35mm |.oX
S50mm | X




ERCROSCOPE ADAFTES

Photo microscopy

Macro at “low’ power

Compared to a lot of cameras and lenses, good
microscopes can be inexpensive. ($250)
http://www.nikonsmallworld.com/

Nikon SLR/DSLR Camera Adapter for
Microscopes

SKU: CA-NIK-SLR
Availability: Instock

$17996
$89.75

¢ Thisis a brand new Nikon SLR/DSLR Camera adapter for
MIiCroscopes.

e Compatible with Nikon SLR/DSLR cameras including D40,
D40X, D50, D60, D70, D70S, D80, D90, D100, D200, D300,
D300S, D3000, D3100, D3200, D3300, D5000, D5100, D5200,
D5300, D5500, D7000,D7100, D7200, (except G series)

e Magnification Power: 2X

e Material: metal
* Mounting Size on Microscope Side: 23.2mm, 30mm and/or
30.5mm

AmScope.com



http://amscope.com

ERCROSCOPE ADARTES

Tentacles of a carnivorous plant (Drosera sp.) - 20x

José R. Almoddvar s

| 3th place winner PR\ >\ \
\ N ™ \ @

http://www.nikonsmallworld.com/galleries/
entry/20 | 5-photomicrography-competition/ | 3



EECOSE-UP LENS FILTESS

Screw on like lens filter. AKA: diopters

Lens focal length Ma}gmﬂcatlon
increase

|00 mm 0.3x
200 mm 0.5x
400 mm 0.8x

Canon 58mm 500D Close-up L@NS saH # cacuL500058 - MFR # 28224001

IN STOCK
Order Now to ship Tomorrow You Pay: $84.95

Free Expedited Shipping

Canon

1 QTY
PRODUCT HIGHLIGHTS

- Attaches to Front Element Add to Cart
- Changes Close Focus Distance
- Range: 500mm to Infinity (19.6" approx)

W W W W v Reviews 46 Q&A 7

Questions? Ask our experts:

500”7 o/ 800.894.9703

>8mm cLose-up LEN®




R USE-UP LENS FILTE

Screw on like lens filter

Pros
* Easy to carry

* Don’t have to mount/remount a lens

Cons

* Need different lens for each filter size

» Minimal magnification with lenses <80mm

» Distance focus lost

» Good close-up lenses may be more expensive than
extension tubes

» Can get complicated where a diopter does not work
with your lens. (see http://coinimaging.com/add-
on_macro.html)



http://coinimaging.com/add-on_macro.html

2R TENSION TUBES

» Different lengths
* No lens elements to add distortion

Kenko Auto Extension Tube Set DG (12, 20 & 36mm Tubes) for
Nikon Dlgital and Film Cameras sa: «keaersno - vrr # AxTusepe N

IN STOCK
Order Now to ship Tomorrow You Pay: $1 2900

Free Expedited Shipping

adKenko

1 qry

W W W W W Reviews 277 Q&A 27
Add to Cart

Similar item at lower price:
Vello Auto Extension Tube Set for Nikon $79.95

Questions? Ask our experts:

o/ 800.894.9703




EXTENSION TUBES

Magnification = normal magnification +
(extension tube length / focal length)

My 50 mm lens maximum reproduction ratio is 0.l 5x
so with 68mm of extension tubes:

Magnification = 0.15 + (68 / 50) = [.5x

Iube Length Reproduction Ratio
(mm)

W 0155
20 0309
36 0.87
o6 iAdl

68 %5



2R TENSION TUBES

50 mm lens + 68 mm |05 mm macro lens + 68
extension tubes Mmm extension tubes

Reproduction Distance to
Lens
(measured) | front of lens

|05 mm macro S 4"

Full uncropped Images

LR AlRR 4 4



50 mm lens + 68 mm |05 mm macro lens + 63
extension tubes Mmm eensin tubes
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50 mm lens + 68 mm |05 mm macro lens + 68

4

extension tubes mm extension tubes
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|O5Smm macro + 68 mm extension tubes - crop
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RTER

L FCCONY

Minimum focus distance does not change

Increase working distance

Can combine with extension tubes or bellows

Always attach to the camera body when you are using

extension tubes or bellows.
A small resolution decrease but it may be made up by

the magnification.



BELLOWS

* Bulky

Extends like a variable extension tube

« Some can work as tilt-shift lens

« Needs rail and lens adapters or new lenses

Novoflex Castbal Tilt-Shift Bellows Attachment ss: :nosacq - vrr# casteaL s

........ Ship Time: 3-7 business days You Pay: $514.99
Free Standard Shipping

1 Qry

PRODUCT HIGHLIGHTS

Add to Cart
- Compact Bellows
- For 35mm, Mirrorless, Medium Format

- Enables Tilt-Shift Macro Photography
- Fits Castel-Q Macro Focus Rack

Reviews 0 [# Write areview  Q&A0 Questions? Ask our experts:

o/ 800.894.9703




BELLOWS

* There are cheap alternatives (no tilt/shift)

FotodioX Macro Bellows for Nikon F Mount Camera Systems

B&H # FOMBNFMCS « MFR # 11BLLWNIKF

Fot@ioX
ST ' Ship Time: 7-14 business days You Pay: $4995

Free Standard Shipping

1 QTY

Reviews 0 [# Write a review  Q&A0 Add o Cart

Questions? Ask our experts:

o 800.894.9703




EAC RO LENDSES

Couplers, reversing adapter, screw-on close-up lens, extension
tubes are all restricted to macro work. Your far focus distance Is
very close to your near focus distance.

Macro lenses are regular lenses that let you get closer. So they
can be used for portraits, landscapes, whatever you want.



EAC RO LENDSES

Like regular lenses but let you get closer:

| 05mm |O5mm
Minimum aperture LS f/32
Angle of View 23 deg /o8ee
Reproduction Ratio Bl S |.Ox

Min. Focusing Distance o ke Ot




MACRO LENSES

All I:1 reproduction or better
Nikon 105mm /2.8 Micro-Nikkor |1 $900
Canon 100mm /2.8 Macro |1 $550-$850
Canon |180mm /3.5 Macro |1 $1,400
Canon MP-E /2.8 1-5x Macro 5:1 $1,050

Versatile:

- Expensive but used prices can be 1/3 for older models
* Focus ~| foot to infinity

» Can use for any type of photography, not just macro

» HIGHLY recommended for close-up and macro




_|
v
3
S
1]
A8
_|




Bl IING THE SHICES

You don’t need to do all (or any of these).

Manual focus

Use a tripod

Remote shutter release (or timer, possibly with mirror up)
If no remote, don’t stab the shutter, gently squeeze while
slowly exhaling

Rail for critical focus at high magnifications (> |:1)

Live view zoom for focus at high magnifications!!!

Break the wind to keep plants from moving (reflector works
well) or use clamps/brace

Focus your mind to lower your heart rate

Have a martini to steady your nerves

And ...






el [ING T'HE SPICES

OrWork Fast

- Hand hold

- Up the shutter speed

- Use flash if you need to for a good aperture, iso and to freeze
motion (this will probably happen often)

- Pre-focus

- Move the CAMERA not the focus ring (once you are close)

Where would you want to work fast?
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Bee’s don't stay still unless
they are dead.

This one wasn’t.

Shallow depth of field

for subject isolation.
Flash for low ISO.

SO 00

|O5Smm x |.5CF = |5/mm
f//.1

1 /200

Flash




gt

Getting the flash off axis




Biatie

Flash gives you a lot of creative control

» Can darken the background

* Freeze motion

* Let you use low ISO for low noise

* Let you use small aperture for larger DOF



Biatie

On camera flash.




FLAST

Off camera flash. Light just what you want.




Hawk Moth

SO 100
|O5Smm
f/ 7.1

| /2000

Possible iImprovement:
Flash could have darkened
the background, let me
use noise free 1so, and let
me shoot at a smaller
aperture for greater DOF.




SO 00
| 80mm
f/ 18

1 /200
Flash




FEA D1 VVI T HSINCICEE

Remote trigger is VERY convenient

and may be already built into your
flash.
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Biatie




Tripod

,,,,,

Shooting down



Position down low
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DTS

Aperture
Sensor size
lens focal length
focus distance

f/3.2 shown

OF

-IEL




D

Aperture
Sensor size
lens focal length
focus distance

f/1 6 shown

OF

T




e OF FIELD Al | RO

Full Frame sensor, 105 mm macro lens, at one foot from
subject.

Nearest Acceptable Furthest Acceptable

Absriure Sharpness Sharpness Tota DOF
f/4 11.97" 12.03" ~0.06"
"""""""""""" ol ons S pe- i TR
""""""""""" o R LT PR o

Macro Depth of Field Calculators:
* http://www.kielia.de/photography/calculator/

» http//www.photopills.com/calculators/dof-macro
* phone apps



http://www.photopills.com/calculators/dof-macro

e T Or FicEEs

Cheat Sheet

DOF doubles when aperture doubles.
For example, /4 > £/8. That is TWO stops.

Each stop is 1/2 the light. So going from /4 to /8 (two
stops) is 1/4 the light. This has to be compensated by a
reduction in shutter speed, an increase in iso, or use a

flash.

Halving the subject distance reduces the DOF by over 4x.
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L US STACKHT

RERVCR Adicc D dep it @RS

Combine the in-focus parts of multiple images to
create a depth of field that is impossible with a
single shot.

» Take multiple pictures at different focus planes.
e Align

e Blend

Avoid on camera flash (probably cause halos)
Subject better be pretty still



ECUS S TACKING: IMAGES
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FOCUS STACKING: IMAGE 26




BT US S |ACKING: FINAL STASSS




Ken Els







US> TACKHNE

Not just a macro technique!

Can focus stack landscapes or whatever you want.



L US STACKHT

Take pictures with overlapping focus by
« Manual lens focus OR

» Use software to control the camera focus (e.g. Helicon Remote
(excellent), or Camranger) OR

e Use a manual rail OR

» Use an automated rail (e.g. Cognisys Stackshot) for extremely
shallow focus slices



US> TACKHNE

Can be done in Photoshop
OR specialized software like:

Helicon Focus (heliconsoft.com)

Zerene Stacker (zerenesystems.com)

and others


http://heliconsoft.com
http://zerenesystems.com

US> TACKHNE

» Helicon Focus
e Import images
« Click merge
« Photoshop
 File > Automate > Photomerge OR

« Putimages in layers and: Edit > Auto-Align Layers then Edit > Auto-
Blend then Layer > Flatten Image



PO US S TACKHNES

For extreme macro and
repeatability, Cognisys StackShot
automated rail.

A < e B
’ P onr - w
I £ 8 N O% oy
e U5 7 vy s 4 3
£ 6 et &K | Sl

of N

Macro Rail Package
Includes Power Supply and Motor Cable
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Image from https://www.cognisys-inc.com/

Steve Gettle



RS E-UP VIS

Sample video shot over 49 hours
1432 shots
one shot every 2 minutes
Video run length 30 seconds






O E- U VITIEES

Shot in raw (7360 x 4912 px) for adjustments and cropping
with Interval Timer (still frames)
not time-lapse (video)

Final product was HD Video (1920 x 1080 px)



WATER DROPS

Fun




NEXT MACRO 5IG OUTING

55mm to 62mm reversing ring
Oil and water

ASaturday February 27 |
Indoor macro shoot at CSU

Light box
Light tent

Water drops

Sony extension tubes Other stuff
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